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Switching Catalogs

When you first install OYC it will be set to use the mailing list

catalog format.    To switch to another catalog:

1) Click on "File" in the menu bar at the top of the screen.

2) On the File Menu click on the "Catalog Maintenance" option.

3) In the "Catalog Maintenance" window you can select the catalog

you want to use by double-clicking on its name in the "Catalogs"

box on the lower left side of the window.

4) The current catalog's name is shown in the very lower left

corner of the window.    When the name of the catalog you want to

use is shown here, click on the "OK" button to return to the Main

Screen.

OYC will continue to use the catalog you've selected until you

select a different catalog.



Entering Information In Your Catalog

Each time you start the OYC software you will see a blank Main

Screen.    You can immediately start typing information for a new

entry on this screen--just fill in the blanks.    When the entry is

complete click on the "Save" button or push "F5".

Entering Text

Entering Numbers

Entering Dates



Entering Text

When entering information about a series of similar items the F3

key (or you can use the "Copy" button at the top of the screen)

will save a lot of time.    Push "F3" to copy all of the

information from the previous entry. You can then type over the

information that needs to be changed for the new entry.

Be Consistent

It is very important that you be consistent in how you enter

information in your catalog.    In order for you to be able to

search your catalog, and find what you need, the information has

to be entered in a consistent way.    For example, always spell

words the same way, do no use alternate spellings.    If you use

abbreviations or codes, use the same abbreviation or code each

time you abbreviate a word or phrase.    When entering dates, don't

use slashes sometimes (mm/dd/yy) and dashes (mm-dd-yy) other

times.

Memos



Memos

If you have a lot of text information about a particular item,

you can use the memo screen.    The advantage of the memos are that

you can type in paragraphs of information.    The disadvantage is

that the information in the memos can not be searched or

alphabetized.

If you have text information, that you'd like to be able to

search, then you should set up several long fields in your

catalog and use them for the text information.    Otherwise the

memos are a great way to store a lot of information about an

item.

To enter a memo:

1) Click on "Edit" in the menu-bar at the top of the screen.

2) On the Edit Menu click on the "Memo" option. This will open

the "Edit Memo" window.

3) Type the text you want included in the memo, then click on the

"OK" button.    The memo is now saved and attached to the entry

that was displayed on the screen.



Entering Numbers

Unlike other software, you do not need to set up special fields

for entering numbers in an OYC catalog.    Numbers may be entered

at any point in any field.    For example, catalog numbers can have

a combination of numbers and letters.

However, if you want OYC to put numbers (or alpha-numerical

catalog numbers) into the correct numerical order, you must enter

all of the numbers using the same number of digits.    For example,

if the largest number you expect to enter is 5000, then all

numbers must be entered using four digits.    That means number one

would be entered as "0001" and number twenty-five" as "0025".

If the numbers have a decimal point, such as when entering

monetary values, it does not matter how many digits are used to

the right of the decimal point.    Computers see 25.2 as being the

same as 25.20.

Using the same number of digits for all numbers also helps during

searches.    For example, if you search for the number "10" the

software will find "10", "100", "107", and any other number

containing the digits "10".    But if you search for the number ten

as "0010", then only 0010 will be found as a match.



Entering Dates

Dates can be entered in the catalog using any format you'd like,

as long as you are consistent and always use the same format. 

However, in some cases people like to have dates arranged in the

correct chronological order.    Because computers work from left to

right when they determine alphanumerical order, this means you'll

need to enter dates using a specific, left-to-right, format.

If you want OYC to put dates into order by year, and then within

each year have then in order by month, and in each month have all

of the individual days in order; then you'll need to enter the

date using the yy/mm/dd (year/month/day) format.

Always use two digits in dates. For example, enter "2" (for

either February or the second of the month) as "02".    Thus

February 15, 1995 would be entered as: 95/02/15.

In other cases people want to have dates grouped together by

month, for example when listing the birthday's of everyone in

your family.    If this is the case, then entering the date as

mm/dd/yy (month/day/year) will produce the desired result. 

Again, however, all numbers need to be entered using two digits.



Reports

The term "report" refers to the results of a search or listing. 

Reports can be created in a variety of ways and can display a

listing on the screen, or save it in a file on your disk, or

print the listing.    This section discusses how to print a report,

save it in a file, or display it on the Quick View screen

Printing A Report

Saving As Text File

Quick View Screen



Printing A Report

To print a report start by selecting one of the search or listing

options on the View Menu.

See also Sequential Searches, Alphabetical Searches, Global

Searches

Before starting the search or listing click on the "Report Setup"

button this is on the "Search" and "listing" windows.    The

"Report Setup" window provides a variety of options that let you

set the report destination, formatting options, and more.

In the "Report Setup" window use the buttons in the "Report

Destination" box to select where you want the results of the

search or listing to go.    Select "Monitor" or "Quick View" to

display the report on the screen.    Select "ASCII File" or "dBase

File" to save the report in a file on your disk.    Select

"Printer" to print the report.

Paper Options--Types Of Printers

For printed reports you also need to select the right type of

paper option for your printer.    Essentially all printers have a

continuous paper feed. These include laser printers which feed

individual sheets of paper. Continuous paper feed means that you

do not need to manually put each sheet of paper into the printer. 

Thus, in most cases, you should select the "Continuous" option. 

The only excepts are usually for older printers that require

paper to be hand fed.

However, there is another use for the "Single Sheet" option.    If

you'd like to use both sides of the paper, set the "Paper Option"

to "Single Sheet".    As each sheet of paper comes out of the

printer, turn it over and feed it back into the printer so that

the report is also printed on the back side of the paper.

Report Options



The "Report Options" box in the Report Setup window controls

whether a dashed line will be printed between each entry; whether

column headings will be printed at the top of each page; and the

use of the Lock Top Line feature (used ONLY with two line

reports).

In some cases we've had technical support calls from people

having trouble getting their printed reports to look right, and

the problem has been that they have turned on every report option

in this window.    Do not select a report option unless you know

what that option does.    None of these options need to be selected

in order to print a report.

When you are finished with the "Report Setup" screen click on the

"OK" button.

Setting Up A Report Format



Setting Up A Report Format

Before a report can be printed a report format needs to be set up

and selected.    The software comes with several report formats and

you can start printing reports right away using any of these. 

But if you'd like to print your report so it looks the way you

want it to look; or create a new report format, here's what you

do:

1) Click on "Reports" on the menu-bar at the top of the Main

Screen.

2) Click on the "Report Maintenance" option.    When the "Report

Maintenance" window appears, first select the report you want to

use by clicking on its name. 

3) If you want to set up a new report format, click on the "New"

button.    If you are modifying an existing report format, click on

the "Edit" button.

4) The "Edit Report Format" screen shows how the fields will be

arranged when they are printed.    The upper portion of this screen

is used to graphically show a representation of where each field

will be printed.    You can place fields, in the locations where

you want them to print, by selecting a field using the "Name"

drop-down list box, putting the mouse cursor at the location

where you want the field to be printed (on the upper part of the

screen), and clicking the left mouse button.

You can also select a field by clicking on its name, if it is

already displayed as a part of the report format.    Then move the

cursor to the spot where you'd like to relocate the field and

click the mouse.

5) You can have up to 21 lines in a report format.    Several

fields can be placed on each line, so you can print all 21 fields

(if you are using that many) without having a 21 line report

format.    The number of lines in the report format is changed

using the up/down arrows on the lower left of the screen.

6) Once the report format is set the way you want it to be, click

on the "OK" button.



Saving As A Text File

To save a report as an ASCII text file, you first need to go to

the "Report Setup window" to set the report destination.

1) On the "Report Setup" window click on the "ASCII File" button

in the Report Destination box.

2) You must have a valid report format selected (see also

<Setting Up A Report Format>).    The ASCII text file is created

using the same format as is used for the printed reports.

3) Click on "OK" to leave the "Report Setup" window, then start

the search or listing as you would for a printed report.



Quick View Screen

The Quick View option on the "Report Setup" window sends the

result of a search or listing to a screen that displays the

information for 19 entries at one time. 

The Quick View display can hold up to 2000 entries at one time. 

Should the search or listing result in more than 2000 entries,

then just the first 2000 will be displayed.

The Quick View screen can be scrolled to the left and right to

show all of the fields for each entry.    It can be scrolled up and

down to show additional entries.

If you'd like to edit an entry shown on the Quick View screen,

put the mouse cursor in the box containing the information you

want to edit, click once, and make the changes.    They will be

saved when you leave the Quick View screen.



Setting Up Or Changing A Catalog

To set up a new catalog, or modify an existing catalog, click on

"Files" option in the menu bar at the top of the Main Screen and

then click on "Catalog Maintenance" option.

1) In the "Catalogs" box, click on the catalog you want to

modify.    Then click on the "Change Format" button.

If you want to create a new catalog, start by clicking on the

"New" button and then enter the name you want to use for the new

catalog.

2) Then on the format setup screen click on the button for the

field you want to define or modify.

3) To alphabetize a field, click on the button next to the "key"

symbol.    A picture of a key will appear next to the field to be

indexed.

4) To set a field to be totalled, click on the "sum" symbol.    A

sigma symbol, representing summing, will appear next to the field

to be totalled.

5) To change the length of the selected field, click on the "add"

or "subtract" buttons.

6) To change the field title, click on the rectangular box for

the field you want to rename (or name for the first time). Then

type in the field name you want to use.

7) Click on "OK" to save the new settings and leave this screen.



Finding Things In Your Catalog

The searches are used to find things in your catalog.    There are

three types of searches: sequential, alphabetical, and global.

Sequential Searches

Alphabetical Searches

Global Searches



Sequential Searches

With a sequential search you enter the search criteria (what you

want to find) in as many fields as you want--the software will

automatically cross-reference the fields and find matching

entries.    The sequential search will start at the beginning of

your catalog and check each entry, one at a time, for matches.

The advantage of a sequential search is that it can find words

and phrases within the information in a field.    For example, it

can find all song titles (or movie titles, or book titles, etc.)

that contain the word "LOVE".

The disadvantage is that sequential searches are slow because

they have to look at every entry in your catalog.



Alphabetical Searches

Alphabetical searches use the indexes to jump directly to entries

containing the information you want to find.

An alphabetical search must have a "key field" specified that is

used to set the alphabetical order.    You do not have to enter

something to search for in the key field.    You can specify what

you want to find using any field, the search will then list

matching entries based on the alphabetical order of the key

field.

The advantages of the alphabetical search is that it is fast, in

most cases, and that the result is listed in alphabetical order.

The disadvantage of an alphabetical search is that it only finds

matches, when searching for something in the key field, that is

an exact match for the information in that field.



Global Searches

A global search works just like a sequential search, except that

instead of being limited to a specific field a global search

looks for matches in all fields.



Alphabetical Listings

Unlike a search, which looks for specific information in your

catalog, a listing lists everything within a specified range. 

You can list all the entries with a range of entry numbers; or

you can do an alphabetical listing based on a specified field; or

an alphabetical listing within a specified range of the alphabet.




